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1.

Introduction

For a comprehensive introduction to the existing Rapid Oscillations in the Solar Atmosphere (rosa) camera system, please refer to Jess et al. (2010). A copy of this paper can
be located in the “ROSA Documents” folder on the Desktop of the dedicated Hα Shuttle
Box. The newest rosa camera is an Andor Technology DU-897 back-illuminated 512×512
Electron-multiplying Charge Coupled Device (EMCCD). This camera has greatly improved
sensitivity at Hα wavelengths, particularly when compared to the previous generation rosa
cameras. A quantum efficiency curve for the new camera (BV model) is shown in Figure 1.

2.

Using the New ROSA Camera

Those familiar with the existing rosa system should be in an excellent position to use
this new back-illuminated camera, particularly since many features and functions remain
unchanged. However, those who are either new to rosa, or wish to refresh their memory,
may do so by reading the following sections carefully.

2.1.

Connecting the Hα Camera to ROSA

The new DU-897 camera has the same connector interface as found on the existing
rosa cameras (see Fig. 2). As before, the images are transferred to the dedicated Shuttle
Box PC using the white MDR 36 cable, which is plugged into the Andor Technology PCIe
card. The camera is cooled down to −70 ◦ C (−95 ◦ F) via a Peltier cooler, fed by a 7.5 V DC
current. Simultaneous triggering of the camera exposures is dealt with through use of the
“Ext Trigger” pin on the camera connection block. This terminal is connected directly to
the Sync Box of the rosa instrument, allowing simultaneous imaging with all six existing
cameras.
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Fig. 1.— Quantum efficiency curves for the Andor Technology DU-897 back-illuminated
EMCCD cameras. Two models are currently available: the ‘BB’ is designed for near-UV
imaging, while the ‘BV’ model is meant for imaging in the red portion of the optical spectrum.
The newest rosa camera is the ‘BV’ model, which has a quantum efficiency of ≈95% at Hα
wavelengths.

Fig. 2.— Connection terminals present on the new Andor Technology DU-897 Hα camera.
Terminals typically used are the MDR 36 interface connector, the 7.5 V DC Peltier cooler
power, and the Shutter pin for simultaneous triggering with existing rosa cameras.
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2.2.

Setting the Spatial Resolution

Utilizing the Dunn Solar Telescope’s 76 cm entrance apperture, a diffraction-limited
plate scale of 0.109′′ /pixel is achieved for Hα imaging, providing a two-pixel resolution of
approximately 158 km on the solar surface. Using a plate scale of 0.109′′ /pixel would provide
a field-of-view size of 56′′ ×56′′ , slightly smaller than the default 69′′ ×69′′ of the existing rosa
system. As a result, the normal course of action is to utilize the existing rosa beam size, but
due to the new DU-897 camera having a 16×16 µm2 pixel size (compared with the existing
rosa camera’s 8×8 µm2 size), it equates to a DU-897 specific plate scale of 0.138′′ /pixel,
giving an overall field-of-view size consistent with the existing rosa system.
As per the existing rosa setup, high-order adaptive optics (Rimmele 2004) may be used
to correct wavefront deformations in real-time. The acquired images can then be further
improved through speckle reconstruction algorithms (Wöger et al. 2008), typically utilzing
16 → 1 restorations under good seeing conditions.

2.3.

The Shuttle Box PC

The PC used for Hα imaging with the new Andor Technology DU-897 camera is a
top-of-the-line machine built on 2011 May 17. The detailed specifications are as follows:
• CPU: Intel Core i7-950, 3.06 GHz, 8 MB cache
• RAM: Crucial 12 GB, DDR3, 1066 MHz, triple channel
• Local Storage: 2 × 2 TB Western Digital internal SATA
• External Storage: 2 × eSATA, 9 × USB 2.0 ports
• Graphics: ATI Radeon 2400 HD, 256 MB, PCIe
• OS: Windows 7 Home Premium, 64-bit
The machine only has one authorized user, and is accessed using the following login
details:
• Login: Dave Jess
• Password: turbo
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Once logged on to the PC, you will have full root access. Therefore, it is imperative that
you double, if not triple check everything to prevent detrimental problems to the system.
If in doubt about anything, please contact Dave Jess before proceeding (contact details on
front page).

2.4.

Using SOLIS

SOLIS is an Andor Technology developed graphical interface for controlling and capturing data taken using one of their cameras. Before starting SOLIS, the DU-897 camera must
be connected to the PC using the white MDR 36 interface cable, with the necessary power
source also plugged in. SOLIS can then be started by double-clicking the Andor SOLIS icon
on the Desktop. The intuitive interface should result in rapid familiarisation, but the main
technical points are covered below.

2.4.1. Camera Setup
Upon loading SOLIS, you should audibly hear the shutter opening. To avoid damage to
the CCD chip, the shutter needs to be closed as soon as possible, in addition to activating
the Peltier cooler.
1. File → Configuration Files → Load → DBJ ROSA.cfg
2. Hardware → Shutter Control → Internal Shutter = Permanently Closed →
External Shutter = Fully Auto → click OK (shutter should now be heard to close)
3. Hardware → Temperature → Cooler ON → Temperature Setting = −70 ◦ C →
click OK (Temperature reading should begin to drop in lower-left corner of screen)
4. Hardware → Fan Control → High → click OK
Now, all the preliminary setup steps have been completed. All that remains is to modify the
image acquisition parameters. Verify the following in the Setup Acquisition menu tabs:
1. Acquisition → Setup Acquisition
2. SETUP CAMERA:
• Acquisition Mode: Kinetic
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• Triggering: External (when connected to rosa sync box)
• Readout Mode: Image
• Delay of Exposure Period: (user choice based on setup and light levels)
• Number of Accumulations: 1
• Kinetic Series Length: 1048575 (maximum allowed)
• Minimum Trigger Period: (Delay of Exposure Period + Readout)
• Number of Prescans: 0
• Frame Transfer: 
• Isolated Crop Mode: 2
• Baseline Clamp: 
• Shift Speed: 1.7 µs
• Clock Voltage: Normal
• Readout Rate: 10 MHz at 14-bit
• Pre-Amplifier Gain: 4.9x
• Electron Multiplier (EM) Gain: 2
3. BINNING:
• Sub Image: 512 × 512 (Full)
• Binning: 1 × 1
• Perform binning in software: 2
4. AUTO-SAVE:
• Enable Auto Save: 2
• AutoIncrement: 2
• Date: 2
• Camera Type: 2
• Operator: 2
• Computer Name: 2
• Time: 
• Separator:
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5. SPOOLING:
• Enable Spooling: 
• File Type: FITS
• Update Display During Acquisition: 
• Filename: DBJ ROSA
• Location: D:\ROSA Data\
• Format: unsigned 16-bit integer
• Open spooled data when complete: 2
• Use Append Settings from Autosave tab: 
6. IMAGE ORIENTATION:
• The orientation of the images (rotation angle and flip) is left to the discretion of
the user. Under normal circumstances, the option “None” is typically chosen.
7. VIDEO MODE:
• Use Settings from Setup CCD: 
• Allow Spooling in Video Mode: 2
8. DATA AVERAGING FILTERS:
• No Averaging Filter: 
• Recursive Averaging Filter: 2
• Frame Averaging Filter: 2
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Fig. 3.— The most commonly used icons within the SOLIS software. These icons are useful
when attempting to establish exposure times and other camera settings as they remove the
need to trawl through drop-down menus.
2.4.2. Getting the Right Exposure Time
In most cases the new Hα camera will be triggered by the existing rosa system, thereby
operating as a seven-camera instrument. It is therefore important to select the correct
exposure time to insure the camera is triggered at the correct rate, in addition to capturing
images of sufficient signal-to-noise. Utilize the following procedure to help choose the correct
exposure time. Figure 3 will help with icon recognition within the SOLIS software.
1. Insure camera is set up correctly as per § 2.4.1.
2. Acquisition → Setup Acquisition
3. SETUP CAMERA:
• Triggering: Internal (only used for exposure time calibration)
4. Hardware → Shutter Control → Internal Shutter = Permanently Open
5. Click on the Video icon to display streaming images to the screen.
6. Click on the Region of Interest icon.
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7. Click on the Add an ROI icon. A red ROI box will now be drawn on top of the
streaming video images.
8. Using the mouse, drag the corners of the red ROI box until a location of the solar
surface containing both dark and bright structures is present within the ROI.
9. Options → Maximum Scans → Maximum Scans = 1 → click OK
10. Click on the Live Update icon which will display image parameters in real time.
11. Readings (Mean and Maximum) will vary depending on solar structure under investigation. A Mean ∼ 4000 is ideal for good quality image reconstruction. However, insure
the Maximum < 8000, otherwise no overhead is present in the event of increased light
levels or impulsive brightenings.
12. Click on the Abort Acquisition icon to end video imaging.
13. If the exposure time needs to be adjusted, follow the SETUP CAMERA section in
§ 2.4.1, modifying the exposure time as necessary.
14. To re-check the image parameters, simply click on the Video icon again to display
streaming images to the screen. The chosen ROI, and previously defined menu choices,
will remain active unless modified by the user.
15. Repeat this process until you are happy with the Mean and Maximum image counts.
Note down the exposure time.
16. Hardware → Shutter Control → Internal Shutter = Permanently Closed
17. Acquisition → Setup Acquisition
18. SETUP CAMERA:
• Triggering: External (when connected to rosa sync box)

2.4.3.

Setting the Right Trigger Rate

Now that the exposure time has been chosen to maximise signal, a trigger rate must
be defined so that the new Hα camera will work in unison with the existing rosa system.
The maximum rate that the camera can trigger at is defined by the exposure time set above,
in addition to the readout time required to transfer the image off the chip. The following
formulae can be used to decide which rosa sync source to connect the camera to. First, it
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is important to allow for a little overhead to allow for efficient full-chip readout. Typically,
this overhead is 30 ms. The exposure timesync can be related to the exposure timecamera
established in § 2.4.2 by,
exposure timesync = exposure timecamera + 0.03 seconds.

(1)

The sync-specific exposure time can now be inverted to derive the maximum frame rate,
F P S, for the chosen camera exposure time,
FPS =

1
Hz.
exposure timesync

(2)

It should be noted that the F P S value derived above should be close (if not identical) to
the value listed beside the “Delay of Exposure Period” in the Setup Camera menu.
Under normal operating conditions, the default rosa master frame rate is 30.3 Hz.
Therefore, with available dividers ranging from 1–10, the rosa sync rates available for
selection are displayed in Table 1. If the derived maximum Hα frame rate, F P S, falls in
between two sync rate values listed in the right column of Table 1, then the lower rate
(i.e. higher divider) must be chosen. For example, if the Hα frame rate is 6.01 Hz (falling
in between dividers 5 & 6), then divider 6 must be chosen, with the camera subsequently
triggering at 5.05 Hz. Failure to follow this policy will result in non-simultaneity of images
with other rosa cameras, dropped and/or missing frames, and inconsistent FITS header
information.
By programming the remainder of the rosa cameras using the main user interface, it
will become apparent which sync sources (i.e. signal ports on the sync box) correspond to
what master frame-rate dividers. Use a BNC T-piece to split the signal from the sync source
corresponding to the desired Hα divider. Place the T-piece on the output port of the sync
box, and run a trigger cable from this T-piece to the “Ext Trigger” connector on the rear of
the Hα camera. As a result, the new Hα camera will trigger simultaneously with existing
rosa cameras, yet the image sequences will be stored locally on the dedicated Shuttle Box.
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Table 1: Typical rosa sync rates, based on integer dividers found in the drop-down menus
present in the main rosa user interface.
Master FPS Divider
1a
2
3
4
5
6
7
8
9
10
a

Sync Rate
(Hz)
30.30
15.15
10.10
7.58
6.06
5.05
4.33
3.79
3.37
3.03

: Assuming default master frame rate of 30.3 Hz

2.4.4.

Acquiring Data

The shutter must be open before capturing data:
• Hardware → Shutter Control → Internal Shutter = Permanently Open
To take data using the specified exposure times, simply click on the Take Signal icon. Now,
the Hα camera will be ready to capture science images, and will commence as soon as the
accompanying rosa instrument is started. To stop data acquisition, just click on the Abort
Acquisition icon. Otherwise, the data acquisition process will cease automatically once the
main rosa instrument stops. After acquiring data, it is imperative to close the shutter:
• Hardware → Shutter Control → Internal Shutter = Permanently Closed

2.5.

Calibration

As detailed in Jess et al. (2010), calibration files should be acquired to enable accurate
post-facto image reconstruction, alignment and destretching. Please refer to § 5 of Jess et al.
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(2010) for a detailed description of which sequences to acquire. However, for completeness,
typical calibration sequences are listed below:
• Flat fields
• Dark images
• Dot grids
• Line grids
• Air Force targets

2.6.

End of Observations

Once data acquisition has ceased for the day, it is important to turn off the camera’s
Peltier cooler and exit SOLIS cleanly. To do this, follow these instructions:
1. Hardware → Temperature → Cooler OFF → click OK (Temperature reading should
begin to increase in lower-left corner of screen)
2. File → Exit
3. You may be prompted whether or not you wish to save data. Click “No” as data has
already been spooled to disk.

3.

Data Transfer

Each full-chip image is ≈0.5 MB. Therefore, with frame rates of up to 30.3 Hz, an hour
of continual observing will accumulate ∼55 GB of data. Users will need to supply their own
hard drives in order to bring this data back to their home institute. Docking stations are
provided, so all that is required is at least one SATA compatible internal hard drive. From
experience, I would recommend any Western Digital SATA drive, as drive failures with these
are rare. As of 2011 May 23, my drive of choice is:
• Western Digital, 3.5-inch, 2 TB, 7200 RPM, 6 GB/s, 64 MB cache
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Fig. 4.— Disk Management screen, revealing three connected hard disks. Two drives are
internal (Disk 0: Windows OS, Disk 1: data save path), while the third drive (Disk 2) is the
external data backup. Care must be taken to avoid formatting the wrong drive.
The Shuttle Box PC has two available eSATA ports to make data transfer a painless task.
When formatting the disk drive, please be very careful not to format the wrong disk. It is
very important you do not format any other hard drives as this may result in a loss of all
rosa data!

3.1.

Formatting Hard Drive and Transferring Data

The process for formatting and transferring data is straight forward. Both NTFS and
exFAT file systems are supported, with representative transfer speeds of ∼100 MB/s and
∼75 MB/s, respectively. However, as many users will be browsing/processing data on Mac
systems, I recommend you choose the exFAT file system as this is directly compatible with
Mac OS X 10.6.5 and above. Simply adhere to the following guidelines for quick and painless
data transfer.
1. Insure you have exited SOLIS as per § 2.6
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2. Shut down the Shuttle Box PC
3. Insert your hard drive into the provided docking station
4. Plug the docking station into a mains power outlet
5. Connect the docking station to the Shuttle Box PC by means of an eSATA cable
6. Turn on the docking station
7. Wait for 30 seconds for the hard drive to spool
8. Turn on the Shuttle Box PC
9. Log into Windows using the details in § 2.3
10. Double click on the “Hard Drive Maintenance” icon on the Desktop
11. Click on “Disk Management”, producing a screen identical to Figure 4
12. Find your disk drive (most likely located in “Disk 2” slot)
13. Right-click on your disk drive and select “Delete Volume...”
14. Click on “Yes” when prompted
15. Your hard disk will now consist of “Unallocated” space
16. Right-click on the word “Unallocated” and click on “New Simple Volume”
17. Click Next to launch the New Simple Volume Wizard
18. The “Simple Volume Size in MB” should match the “Maximum Disk Space in MB”
19. Click Next
20. Assign the following drive letter = G
21. Click Next
22. Format this volume with the following settings:
• File System: exFAT
• Allocation unit size: Default
• Volume label: Ext Disk
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• Perform a quick format 
• Enable file and folder compression 2
23. Click Next
24. Click Finish
25. Close the “Disk Management” window
26. Double click on the “Computer” icon on the Desktop
27. Your “Ext Disk” should show up as “G:” with ample free space
28. Double click on “Ext Disk (G:)”
29. Double click on “ROSA Data (D)” icon on the Desktop, resulting in two visible windows; one for your external storage disk (Ext Disk), and the other containing all raw
Hα data (ROSA Data)
30. Drag & Drop all files you wish to transfer to your external hard disk
31. Once file transfer is complete, shut down the Shuttle Box PC
32. Turn off the power to the docking station
33. Eject your hard disk and store safely

4.

Concluding Remarks

The purchase of the new Andor Technology DU-897 camera and dedicated Shuttle
Box PC was funded by a Royal Society Research Grant and the Astrophysics Research
Centre, Department of Physics and Astronomy, Queen’s University Belfast. This manual
will be updated on a regular basis, so please email Dave Jess (d.jess@qub.ac.uk) with any
comments/suggestions.
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